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Simple Text para After Effects
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Simple Text cria controladores baseados em shape layers para criar as animagoes. Foi
desenvolvido para seu uso ser simples, vocé usa ferramentas que ja conhece do After
Effects para criar sua animacgao de texto.

SimpleText

"y Crie animagoes de texto em 3 etapas

1. Converta seu layer de texto. Selecione o /ayer de texto e aplique o Simple Text.

2. Crie sua animagao. Use o shape layer para criar a animacao.

3. Defina o tipo de delay e o tempo. Vocé pode escolher diferentes tipos de delay e 0
tempo de entrada entre as letras.

SimpleText - Script de Animagao de Texto https://www.youtube.com/watch?
para After Effects v=mlIMhj0xAPM


https://www.youtube.com/watch?v=mlIMhj0xAPM

Instalacao

@F Tutorial em video

CD SimpleText - Instalacao

A Passo a Passo

After Effecs CC 2019 ou superior
A partir do After Effects CC 2019 é possivel instalar scripts clicando no seguinte menu.
File > Scripts > Install Script Ul Panel...

o Selecione o arquivo SimpleText.jsxbin.
o Feche o After Effects e abra novamente.

After Effects CS 6 a CC 2018
o Copie o arquivo SimpleText.jsxbin na pasta de scripts do After Effects.
Mac OS: Applications\After Effects<version>\Scripts\ScriptUI Panels

Windows:

Program Files\Adobe\Adobe After Effects <version>\Support
Files\Scripts\ScriptUI Panels

o Caso o After Effects esteja aberto, feche e abra novamente.

Iniciando o Simple Text pela primeira vez


https://vimeo.com/399699587

Inicie o script através do menu de scripts do After Effects.
Window > SimpleText.jsxbin
Caso seja solicitado, habilite a opgao Allow Scripts to Write Files and Access Network.

Posicione o script como achar necessario, clicando e arrastando sobre o0 nome do painel.

37 Ajustes para garantir o melhor desempenho

o Caso tenha uma placa grafica compativel, habilite GPU Acceleration.
File > Project Settings... > Video Rendering and Effects
o No After CC 2019 ou superior habilite o JavaScript Expression Engine.

File > Project Settings... > Expressions

O script esta pronto para uso!



Guia rapido

@J Tutorial em video

¢ SimpleText - Guia Rapido

Aprenda em trés passos

&l Converta seu layer de texto

Selecione um /ayer de texto e aperte o botao Simple Text:

e Clique normal para animacao de letras;
o Clique-direito para animacgao de palavras;
« Shift-clique para animacgao de linhas.

) Crie sua animagao

O script criou uma composi¢cao chamada Animator ID:1. Abra esta composicgao e utilize o
layer Animator para criar suas animagoes.

E possivel utilizar os seguintes parametros para controlar as animagdes de seu layer de
texto:


https://vimeo.com/399699778

Anchor Point

Position

Scale
Rotation

Opacity

Para que seu texto fique na posigao original, todos os parametros devem estar zerados,
com excessao da escala e opacidade que deve estar em 100%.

Perceba que é possivel manipular os beziers do path da animag¢édo e também utilizar o
Graph Editor para ajustar as curvas de velocidade entre os keyframes.

Para facilitar a visualizagao e criagao das animacgdes, crie um novo Viewer clicando em

View / New Viewer .

@ Utilize também o atalho ctrl (Cmd no Mac) + Alt + Shift + N .
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EJ Ajuste o delay desejado



Aplicado ao seu /ayer de texto existe um efeito chamado 2DF SimpleText. Nele vocé pode
ajustar o delay de entrada entre uma letra e outra, baseado em segundos.

E possivel também escolher a ordem de entrada. Por padréo, ela é normal, da esquerda
para a direita. Existem botOes especificos para o delay reverso, da direita para a esquerda
e randomico.

Informagoes adicionais

./ Atualizando um texto

Se necessario modificar um texto, pode ser necessario atualizar o Simple Text. Isso
acontece porque o script cria um numero exato de animators para cada letra. Para
atualizar, basta clicar no botdao Simples Text com o layer selecionado, assim ele vai
atualizar a estrutura de animacao.

X Removendo o Simple Text de seu texto

Se desejar remover as animacgodes de sua camada de texto, clique no botao Remove Text
Animations no script. O script mantera todos os efeitos aplicados ao texto.
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Animators

@F Tutorial em video

) SimpleText - Animators

@ Conheca os Animators

Os Animators sao composigoes criadas pelo Simple Text para comandar suas animacgoes

de texto.

@ Para manter a animag&o do texto com o mesmo aspecto da animagéo do
Animator, € importante manter o tamanho 50 para o tamanho da fonte em
média, utilizando o parametro de escala do layer de texto para ajustar seu

tamanho final.

Criando Animators

\ 4

Cada vez em que o Simple Text é aplicado a um layer de texto, um novo Animator é criado.

Os Animator sao identificados por seus respectivos nimeros.

Em seu layer de texto é possivel alternar entre os Animators ja criados digitando o numero

desejado no campo Animator do efeito 2DF SimpleText.


https://vimeo.com/399699626

E possivel utilizar o mesmo Animatorem diferentes layers de texto, basta aplicar o Simple
Text com o Animator selecionado no projeto. Caso o layer de texto ja tenha o Simple Text
aplicado, basta selecionar o numero do animador no efeito 2DF Simple Text.

Caso o Simple Text seja aplicado a mais de um layer de texto, sera criado um animador
para todos eles.

Para criar variagdes de um animador basta duplica-lo.

@ Selecione o animador no projeto e clique ctrl (Cmd no Mac) + D

1 Organizando Animators

Para facilitar a organizacao dos animadores vocé pode utilizar comentarios e subpastas
no projeto.

E possivel salvar seus animadores favoritos. Basta salva-los em um projeto e importar esse
projeto quando necessario.



(X Técnicas avangadas

Com os Animators vocé tem controle total sobre as animacdes. E possivel manipular os
beziers do path da animacao.

Utilize o Graph Editor para ajustar as curvas de velocidade entre os keyframes.

E possivel aplicar expressdes nos parametros de animacao.



Divida seu texto em partes para utilizar mais de um animador com tipos de delays
diferentes na mesma frase.




FAQ

Recebi uma notificagao ao final de um render, o que
significa?

After Effects

Unable to execute script at line 0. After Effects error: Can not run a script while a
modal dialog is waiting for response.

Dependendo da versao do seu After Effects vocé pode receber essa mensagem. Isso tem a
ver com a tecnologia utilizada para criar os botdes, mas nao tem nenhum impacto no seu
trabalho.

No maximo, pode ser necessario reiniciar o script, fechando e abrindo ele novamente pelo
menu Window no After Effects.

Os botoes do script estao piscando ou sumiram, o que
fazer?

O After Effects é um software dindamico, as vezes em algumas atualizagcdes eles acabam
esbarrando em configuragdes que alteram o comportamento de alguns scripts.

Isso pode causar esse tipo de comportamento no Simple Text. Geralmente os botdes
voltam ao normal sozinhos, mas se necessario, feche e abra o script novamente pela menu
Window no After Effects.



O script parou de funcionar subitamente dando uma
mensagem de erro no estilo ‘Unable to execute script at
line X'.

Geralmente esse tipo de erro se resolve também fechando e abrindo o script novamente.
Algumas vezes esse processo precisa ser feito duas vezes para garantir que o script
reinicie completamente.

A causa desses erros podem ser as mais variaveis, mas na grande maioria dos casos so
reiniciar o script ja resolve o problema.

Recebi a mensagem "This script is optimized to work with
up to 100 letters. The layer X has X letters, you may face
some instability. Do you want to continue?". O que fazer?

O script depende de varias linhas de express6es em cada letra para tornar as animagdes
possiveis. Isso faz com que grandes numeros de letras possam sobrecarregar o
funcionamento do After Effects. Na pratica o script vai continuar funcionando, mas pode
vir a ficar mutio lento dependendo do seu hardware.

Estou com previews e renders muitos lentos, porque?

O script depende de uma infinidade de expressdes para fazer com que se possa criar
animagdes de texto de maneira mais rapida e intuitiva. Isso pode fazer com que a seu After
Effects ou seus renders figuem mais lentos ao trabalhar com muitos textos
simultaneamente. A solugcao nestes casos é pre-renderizar com alpha os layers ou
composicoes que ja estao finalizadas. Isso vai reduzir o numero de expressdes sendo
calculadas, e tornar seu workflow mais rapido.



Agradecimentos
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Gratidao e Reconhecimento

Espero que este script consiga alcancgar o objetivo de ser simples o bastante para tornar a
vida do usuario mais facil ao tornar as animagdes de texto no After Effects rapidas e
intuitivas.

Estudar scripts e criar uma solugdo que pode gerar valor real os usuarios soé foi possivel
porque eu pude contar com pessoas que usaram seu tempo para me ajudar a aprender
essa nova habilidade. Seja criando cursos, testando o script ou mesmo dividindo o
conhecimento de maneira muito aberta de forma que talvez eu nunca consiga retribuir o
suficiente.

Por isso, agradeco a todos que contribuiram, desde a fase inicial de pesquisa desse projeto
que aconteceu via redes sociais e mailing do 2DeadFrog, em que muitas pessoas
compartilharam suas dificuldades em relagdo a animacao de texto no After Effects.

Agradecimentos especiais a estas pessoas, algumas muito proximas,
outras hem imaginam quem eu sou:

 Cristina Camila Marques: Esposa incrivel, mesmo no primeiro ano da nossa filha
Camila e terceiro ano do nosso filho Lucas (aquela fase em que as criangas sao
incansdveis), e durante a pandemia do Covid-19 que nos deixou presos em casa,
tornou possivel eu encontrar espagco no meu tempo para estudar e me dedicar a este
projeto.

o Adam Plouff: Além de criar ferramentas incriveis que eu uso todos os dias, ele € um
cara incrivel que respondeu a todos 0s meus questionamentos de uma maneira super
aberta e sincera. Ele também desenvolveu a ferramenta de interface base usada no
script, chama de Battlestyle.

e Arthur Ferraz: Por criar os audios dos promos e tutoriais do Simple Text.

e Gabriel Goldman: Por todo o suporte com os tutoriais e testes iniciais do script em
Mac OS. Ele também me fez ter a ideia inicial para criar o script, talvez mesmo sem


https://www.battleaxe.co/
https://github.com/adamplouff/scriptui-battlestyle
http://arthurferraz.com/
https://vimeo.com/gabrielgoldman

saber.

Ricardo Fuijii: Pela locugdao em portugués do video promo.

Felipe Vieira: Mais conhecido como Beico, pelo apoio no langamento e pelas licdes
compartilhadas.

Filipe Campeiro: Beta tester e ndo s6 do produto mas também das estratégias e
langamento.

Jeferson Moreira: Beta tester engajado, com sugestodes criativas.

David Torno: Otimo curso sobre scripts e também muito solicito, respondendo as
minhas duvidas sempre.

Dan Ebbert: Pude contar com a ajuda de muitas pessoas em féruns com respostas
que se encaixavam perfeitamente aos meus questionamentos sobre expressodes e
scripts. Em 90% dos casos era esse cara que tinha a resposta correta aos meus
questionamentos.

Jeff Almasol: Desenvolve o RD Scripts, ferramentas 6timas, que tornam a vida de
guem desenvolve scripts muito mais facil.

Nico Duduf: Além de desenvolver o incrivel DUIK, mantém o projeto gratuito e open
source, 0 que € muito importante para quem esta estudando scripts.

Mathias Moll: Cursos incriveis ndo sé sobre scripts, mas também uma iniciagao ao
mundo da programacgao.

Tomas Sinkunas: Desenvolvedor de scripts para AE, em tempos de CEP ele continua
estudando e levando o Script Ul ao seu limite, e disponibilizando os cédigos de seus
estudos.

Lloyd Alvarez: Curso muito interessante e pratico de criagao de scripts.

Zack Lovatt: O guia de estudo que ele indica para quem quer aprender scripts é
perfeito. Ele também é muito ativo nas comunidades desenvolvedoras de scripts,
ajudou muito com as contribuigées em féruns de discussao.

Amigos e familia em geral que pude conversar sobre esse projeto em todos os niveis.
Uma infinidade de usuarios das comunidades de motion graphics e féruns de After
Effects.


http://vidademotion.com.br/
https://www.behance.net/filipecampeiro
http://sublimestudio.com.br/
https://vimeo.com/davidtorno
https://www.motionscript.com/
http://www.redefinery.com/ae/
https://duduf.com/
https://mamoworld.com/
http://www.rendertom.com/
http://aescripts.com/
https://zacklovatt.com/






